
Amberlight Manual 
v.1.2  

 

 
 
 
Willkommen zu Amberlight! 
 
Amberlight ist ein einzigartiges Kunstwerkzeug, welches wunderschöne computergenerierte 
Bilder kreiert. Ein Millionen von Teilchen fliegen durch Ihre Leinwand und man kann sie mit den 
speziellen Amber Felder steuern. Egal, ob Sie ein erfahrener Künstler oder ein kompletter 
Kunstanfänger sind, mit dem Spielen und Experimentieren mit diesem Werkzeug können Sie 
fantastische Bilder erstellen. In der Welt der Computerkunst ist es ein one-of-a-kind Werkzeug, 
welches Ihren künstlerischen Horizont erweitert und ein ganz neues Kunsterlebnis bietet. 
 
Ähnlich wie beim Flame Painter, Amberlight wurde ursprünglich als ein Experimentierprojekt in 
meiner Serie "I am an Artist” entwickelt. Meine erste Vision sollte ein Programm sein wo jeder 
etwas Schönes gestalten konnte. Es sollte ein Werkzeug sowohl für den Künstler als auch für 
Leute ohne künstlerisches Talent sein, die was Einzigartiges gestalten wollen. 
Der Mangel an Inspiration ist oft der Grund warum Menschen nicht kreativ sind, jedoch können 
die Werkzeuge die wir nutzen eine Quelle der Inspiration sein. Mit jedem Werkzeug, das einen 
inspiriert, kann jeder zum Künstler werden.  
Dieses Manual umfasst die Funktionen und Anwendung des Programms und erklärt Ihnen was 
Sie wissen müssen, um Amberlight zu verwenden und wie eine ganz neue kreative Art und 
Weise der Selbstdarstellung zu finden. 
 
Danke, dass Sie Amberlight erworben haben. Wir hoffen Sie haben viel Spaß damit! 
 
              Peter Blaškovič 
         Entwickler von Amberlight  



Benutzeroberfläche 
 
 

Scene Panel 
 

Zoom Out / Rauszoomen - aus dem Bild 
herauszoomen (bis 5%). 
Zoom In / Einzoomen - in das Bild reinzoomen (bis 
800%). 
Reset Zoom / Zoomfaktor zurücksetzen - Bitte 
Zoomwert überprüfen. Beim Click auf diesem Button 
wird auf 100% gezoomt. 
 
Edit / Bearbeiten - Zum Felderbearbeitungsmodus 
umschalten. 
Fields / Felder - Felder-Zahl Einstellung (1-12) 
Delete field / Felder löschen - Ausgewählte Felder 
löschen. 
Random / Zufallsgenerator - Zufällige Szenen und 
Felder. 
Clear / Leeren - Szeneinhalt leeren. 
Render / Rendern - Szene rendern. 
Step / Schritt - Render-Schritt-Zahl einstellen. 
Wenn Sie reibungslos gerenderte Szene haben 
möchten, setzen Sie das auf 10000 oder sogar 
100000. 
Use actual value / Aktuellen Wert benutzen - Den 
aktuellen Wert den Schritte wie Endwert benutzen. 
 
 
Contrast Curve / Kontrastkurve 
 
Es gibt vier verschiedene Kontrasteinstellungen: 
 
Base / Basis - Stellt die Basis der Kontrastkurve - 
Schatten.  
Peak - Stellt die Spitzen der Kurve - Highlights.  
Limit - Stellt den Grenzwert der Kurve - Höhepunkt. 
 
Opacity / Opazität - Opazitätswert des Amberlight-
Werks einstellen (0 - 100). 
  



Filter 
 
Dies sind die Filterparameter für Sie zu experimentieren: 
 
Tint - Farbverlauffilter ein- und ausschalten, drehen und stellt den Farbton und Radius (0 - 
100). 
Glow - Leuchteffekt ein- und ausschalten 
 Radius - den Radiusschein stellen (0 - 100). 
 Strength / Stärke - die Scheinstärke stellen (0 - 100). 
 
 

Farbfenster 
 
Color | Gradient - Auswahl der Füllmethode. Eine Farbe oder mit einem Farbverlauf. 
 
 

Color / Farbe 
 
Pinselfarbe auswählen. 
 
H - Farbton (0 - 359) 
S - Farbsättigung (0 - 255) 
L - Helligkeit (0 - 255) 
 
Palette - Farbe auswählen 
 
Use as Gradient - Ausgewählte Farbe ändert sich auf 
das Farbverlauf 
 
(+) (-) - Farbfeld hinzufügen oder entfernen. 
 
Ein einzelner Mausklick auf einem Farbfeld öffnet 
die Farbauswahlpalette. 
  



Gradient / Farbverlauf 
 

Wählen sie einen Farbverlauf und klicken Sie  auf die 
zu ändernde Farbe unterhalb des Farbverlaufs. 
Einzelne Farben des Verlaufs können ein- bzw. 
ausgeschaltet werden. 
 
Shift - Farbverlauf nach rechts verschieben 
Flip - Verlaufsübergang spiegeln 
Invert - Farben in Farbverlauf invertieren 
 
Gradient to Black - Farbverlauf zur schwarzen Farbe 
ändern.  
Gradient to White - Farbverlauf zur weiβen Farbe 
ändern.  
 
H | S | L - ändert Farbton, Sättigung und Helligkeit 
aller Farben im Verlauf. 
 
(+) (-) - Farbverläufe hinzufügen bzw. entfernen. 
 

 
 

Layers Panel / Ebenenfenster 
 

Mit dem Ebenenfenster man kann die Ebene 
bearbeiten and mit den Einstellungen 
manipulieren. 
 
Blending - Ebenenmodus. 
Opacity - Deckkraft der Ebene (0 - 100). 
Eye / Augenicon - Ebene sichtbar oder unsichtbar 
machen. 
Background Color / Hintergrundfarbe - 
Hintergrundfarbe verstecken oder zeigen und 
Farbton wählen. 
 
Import Image - Das zweite Bild für Komposition 
importieren.  
Clear Layer / Ebene leeren - Ebeneninhalt 
(Amberlight oder Image) leeren. 
 
  



Edit Fields / Feldbearbeitung 
 

Drücken Sie Edit-Taste im Szenepanel oder linke Maustaste auf der Leinwand, um Felder zu 
bearbeiten. Sie können das Zahl der Felder im Szenepanel von 1 bis 12 einstellen. Jedes Feld 
wird als ein Kreis mit Position und 3 Parameter repräsentiert. Mit diesen Parametern können 
Sie einstellen, wie die Felder die Partikel beeinflussen werden. 
 

Feldparameter: 
 
Center Position - (A) - Drücken Sie die linke 
Maustaste auf der Mittel Kreis-Taste und 
positionieren Sie das Feld auf der Szene. 
  
Force / Radius des Kraftfeldes - (B) - Drücken Sie 
die linke Maustaste und stellen Sie die Kraft des 
Feldes mit der Bewegung links oder rechts. Rechts 
von der Mitte hat das Feld die positive Kraft (+), 
links von der Mitte hat es negative Kraft (-). 
 
Intensity / Intensität - (C) - Drücken Sie die linke 
Maustaste und stellen Sie die Feldintensität mit der 
Bewegung nach oben und unten. Entfernung von 
der Mitte setzt den Intensitätswert. Nach oben ist 
es höher, nach unten von der Mitte ist es niedriger. 

Mit diesem Parameter beeinflussen Sie, wie intensiv der Einfluss des Feldes auf die Partikel ist.  
 
Cut-off / Schutzschild” - (D) - Drücken Sie die linke Maustaste und stellen Sie die Schutzschild 
mit der Bewegung nach oben und unten. Entfernung von der Mitte stellt, wo die 
durchfliegenden Partikel vor dem Kraftfeld stoppen. 
 
Drücken Sie Strg / Cmd im Edit-Modus zu verschieben, zoomen oder drehen alle Felder aus. 
Mehr Infos in Tastenkürzel-Sektion. 

  



Die Menüleiste 
 
File / Datei - enthält Elemente im Zusammenhang mit Laden, Speichern, Exportieren und 
Veröffentlichen Ihrer Bilder. 
Scene / Szene - enthält Elemente im Zusammenhang mit Bearbeitungswerkzeuge und 
Leinwand. 
Filter - enthält Elemente im Zusammenhang mit Bildfiltern. 
View / Ansicht - enthält Elemente im Zusammenhang mit dem Ansichtsfenster. 
Windows / Fenster - enthält Elemente im Zusammenhang mit der Benutzeroberfläche. 
Help - / Hilfe - enthält Elemente mit welchen Sie die Anwendungshilfe bekommen, neue 
Updates auf die Webseite. 
 
 

File Menu (Datei) 
 
New... / Neu… - Erzeugt ein neues Bild mit neuen Einstellungen. 
Open... / Öffnen… - Öffnet ein gespeichertes Bild. 
Save... / Speichern… - Speichert das aktuelle Bild. Wurde das Bild noch nicht gespeichert, wird 
nach einem neuen Namen gefragt. 
Save As… / Speichern unter… - Speichert das aktuelle Bild mit einem neuen Dateinamen. 
Quit / Beenden - Programm schließen. (Nur für Windows) 
  
Siehe auch Kapitel „Erzeugen, Öffnen und Speichern von Bildern“. 
 
 

Scene Menu / Szene Menu 
 
Canvas Size… / Leinwandgröße… - Ein neuer Dialog öffent sich, Sie können die Szenegröße 
einstellen. Sie können wählen, ob Sie das Seitenverhältnis der Szene halten wollen (Keep 
aspect ratio) oder ob Sie die Felder zu skalieren (Scale fields) möchten. 
 
Edit / Bearbeiten - Feld-, Position- und Paramenterbearbeitung (Kraft, Intensität und Cut-off)  
Random / Zufallsgenerator - Zufällige Szenen und Felder. 
Clear - Szeneinhalt leeren. 
Render / Rendern - Szene rendern. 
 
Import Image... - Importieren Sie das zweite Bild als eine Ebene. Das Bild wird in der Größe 
verändert die zur tatsächliche Leinwandgröße past. Sie können es auf jede Größe ändern. 
 
 

Filter Menu 
 

Tint - Tint Filter ein- und ausschalten. Stellen Sie den Farbton und Radius im Szene-Panel.  
Glow - Leuchteffektfilter ein- und ausschalten. Stellen Sie den Radius und Kraft im Szene-Panel. 
Tile Layer / Kachelebene - Kachelt die Ebene (horizontal und vertikal) 



View Menu / Ansicht 
 

Zoom In / Einzoomen - in das Bild reinzoomen (bis 800%). 
Zoom Out / Rauszoomen - aus dem Bild herauszoomen (bis 5%) 
Zoom 100% - Bitte Zoomwert überprüfen. Beim Click auf diesem Button wird auf 100% 
gezoomt. 
 
 

Window Menu / Fenster-Menü 
 
Das Fenster-Menü enthält Elemente im Zusammenhang mit den Ansichtsfenster und 
Benutzeroberfläche. 
 
Scene / Szene - Szenefenster zeigen oder verstecken. 
Palette / Palette - Palettefenster zeigen oder verstecken. 
Layers / Ebenen - Ebenenfenster zeigen oder verstecken. 
 
Stay on Top / Bleib auf der Spitze - Die Applikation bleibt immer auf der Spitze der anderen 
Applikationen. 
 
 

Help Menu / Hilfe 
 
Help / Hilfe - Öffnet dieses Dokument (in Englisch) 
Amberlight  Website - Link auf die Webseite: amberlight.escapemotions.com 
About Amberlight - Informationen über Amberlight, Copyright und Danksagungen. (In Help 
Menü nur für Windows.) 
Show Gradients Folder / Gradients Ordner zeigen - Den Ordner zeigen wo die Farbverläufe 
gespeichert sind. 
  



Erzeugen, Öffnen und Speichern von Bildern 
 

Ein neues Bild erzeugen 
 
Mit STRG+N oder über den Menüpunkt File -> New… wird ein neues Bild zu erzeugt. Ein 
Dialogfenster erscheint, in welchem man die Bildgröße und weitere Einstellungen angeben 
kann. “Picture Size Info” gibt die Druckgröße des Bildes an. 
 
Mit dem Farbbutton Custom... kann man die Hintergrundfarbe auswählen - Schwarz, Weiss 
und None (transparent). 
 
Bestätigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel. 
 
 

Ein Bild öffnen 
 
To open a painting, select the Open... option from the File Menu. This panel lets you open a 
picture (PNG, JPG, BMP, TIFF) or previously saved artwork (in AMB file format) and set up the 
properties. Beim Öffnen eines vorher gespeicherte Kunstwerk, das Bild wird wieder neu 
gerendert werden. 
 
Mit STRG+O oder über den Menüpunkt File -> Open... öffnet man ein Bild in PNG, JPG, BMP, 
TIFF Dateiformate oder ein bestehendes Bild in Amberlight in AMB Dateiformat.  
 
Öffnen Sie das Bild mit OK oder brechen Sie mit Cancel ab. 
 
Sie können das Bild direkt aus einer beliebigen Quelle ziehen und ablegen (Drag and Drop 
Funktion) - Es kann Ordner, Browser oder Website sein. Es öffnet sich als „Image“ Ebene.  
 
 

Saving a Painting 
 

Über die Menüpunkte File -> Save… speichert man das Bild auf die Festplatte. Flame Painter 
nutzt ein eigenes Dateiformat mit der Endung AMB. In der Datei sind alle Informationen des 
Bildes und der Ebenen enthalten. Nutzen Sie dieses Dateiformat, wenn Sie später an einem 
bestehenden Bild weiter arbeiten möchten. 
  
Weitere Dateiformate stehen zur Verfügung, jedoch werden Detailinformationen nicht mit 
abgespeichert. Achten Sie darauf, dass sich die Hintergrundfarbe eventuell ändern könnte. 
Beispielsweise werden Transparenzinformationen nicht im JPEG-Format abgespeichert.  
 
Wenn das Bild mit spezifischen Einstellungen oder für andere Programme lesbar abgespeichert 
werden sollen, nutzen Sie die Save Funktion über den Menüpunkt. Das Bild lässt sich in den 
Formaten PNG, TGA, TIF, BMP oder JPG abspeichern.  
 
Speichern Sie das Bild mit OK oder brechen Sie mit Cancel ab.  



Veröffentlichen eigener Werke in der Online-
Galerie 

 
 

Galerie-Konto erzeugen 
 
Um eigene Werke zu veröffentlichen, ist ein eigenes Konto erforderlich. Anbei die 
Beschreibung zweier Vorgehensweisen:  
 
Aus Amberlight heraus: 
Konto über den Menüpunkt File -> Publish Preferences erzeugen. Geben Sie Ihren Namen, E-
Mail (“Your ID”) und Passwort ein. Optional ist die Angabe der eigenen Webseite. 
 
Auf der Webseite: 
Auf der Flame Painter Gallery Webseite loggen Sie sich über login -> Create Account ein und 
geben Ihre “Your ID” (Ihre Registrierungs-E-Mail) an. Sie erhalten per E-Mail ein Passwort 
zugeschickt. 
Bem.: "Your ID" wird im Programmmenü Help -> About Amberlight angezeigt. Sollte "Your ID" 
nicht existieren, geben Sie Ihre aktuelle E-Mail-Adresse ein. 
 
 

Veröffentlichen eigener Werke 
 
Um ein eigenes Werk in der Galerie zu veröffentlichen, nutzen Sie den Menüpunkt File -> 
Publish... Geben Sie Ihrem Werk einen Namen (Artwork Name), eine Bechreibung (Description) 
und Stichwörter (Tags). Durch das Klicken des Publish Buttons wird Ihr Bild auf der Flame 
Painter Gallery Webseite (www.escapemotions.com/gallery) veröffentlicht. Die Bilder dort 
können auch nachträglich weiter bearbeitet warden. 
 
 

Galerieprofil und Bilder bearbeiten 
 
Gehen Sie auf die Gallery website, loggen Sie sich über login ein und geben "Your ID" und 
Password an. 
Im Bereich Edit Pictures können u.a. Namen, Beschreibungen und Stichwörter bearbeitet 
werden. 
Im Bereich My Profile kann das Passwort geändert warden. 

  

http://www.escapemotions.com/gallery


Tastenkürzel: 
 
 
    Windows    Mac OS 
 
New... / Neu...   Ctrl-N     Cmd-N 
Open.../ Öffnen...  Ctrl-O     Cmd-O 
Save/ Speichern  Ctrl-S     Cmd-S 
Save As... / Speichern unter... Ctrl-Shift-S    Cmd-Shift-S 
Quit / Beenden  Ctrl-W     Cmd-Q 
 
Size... / Grösse...  Ctrl-E     Cmd-E 
 
Edit Mode /  
Bearbeitungsmodus  E     E 
Edit all fields in Edit Mode  Ctrl     Cmd 
Pan Fields in Edit mode Ctrl + RMB    Cmd + RMB 
Zoom Fields in Edit mode Ctrl + Mausrad oder LMT  Cmd + Mausrad oder LMT 
Rotate Fields in Edit mode Ctrl + LMB    Cmd + LMB 
 
Wert um 1 vergrößern Pfeil nach oben   Pfeil nach oben  
Wert um 1 verringern  Pfeil nach unten   Pfeil nach unten 
Wert um 10 vergrößern Pfeil nach oben   Pfeil nach oben 
Wert um 10 verringern Pfeil nach unten   Pfeil nach unten 
 
Move a Canvas /  
Leinwand bewegen  Rechte Maustaste oder Leertaste + Linke Maustaste 
 
Zoom In / Reinzoomen Ctrl - +     Cmd - + 
Zoom Out / Rauszoomen Ctrl - -     Cmd - - 
Zoom 100%   Ctrl - 0     Cmd - 0 
Zoom In | Out /  
Rein- und Rauszoomen Mausrad oder Alt + Mausrad 
 
Help / Hilfe   F1     Cmd + ? 
  



Copyright & Danksagungen 
 
 
Amberlight © 2013-2014 Escape Motions, s.r.o 
Amberlight © 2009-2012 Peter Blaškovič 
 
 
Amberlight Team: 
 
Peter Blaškovič, Michal Fapšo, Veronika Klimeková, Andrea Vachová 
 
 
Unser besonderer Dank geht an: 
 
alle, die mit Ideen, Anregungen beigetragen und Amberlight finalisieren geholfen, 
insbesondere Jozef Bardík, Jaroslav Kaša, Daniel Innes, Tomáš Lancz, Harvey Bunda, Devraj 
Baruah, Rana Dias, Nigel Brewster, Jim Kanter, Rastislav Piovarči, Gregorii Trombo. 
 
Übersetzung und Korrekturen: Tanya Hayman, Veronika Klimeková, Marta Fernandez, Andrea 
Vachová, Irene Briz. 

User Interface Icons / Benutzeroberfläche Ikonen: "Batch" by Adam Whitcroft 
 
 
Libraries / Bibliotheken: 
 
Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden: 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 
CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
 
 
Gott sei Dank für alle kreativen Ideen.  

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/


Amberlight End-User Software License Agreement  
 
 
Copyright © 2013-2014 Escape Motions, s.r.o. All Rights Reserved. 
Copyright © 2009-2012 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Amberlight 
software (the "Software"). By downloading, installing, copying, or otherwise using the 
Software, you acknowledge that you have read terms and conditions of this license, 
understand them, and agree to be bound by them. If you do not agree with these terms and 
conditions, Escape Motions is unwilling to license the Software to you, and you are not 
authorized and may not use the Software. 
 
 
Permitted Use  
 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
The Software may be installed on a computer that is for multiple users but it may not be 
installed on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
Users may use the Software for commercial or for-profit activities as well as for personal, non-
commercial, or non-profit activities.  
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
 
Restrictions  
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty.  This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not:  
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.  
b, Sell, rent, lease, assign, or sublet the Software or portions thereof.  
c, Grant rights to any other person.  
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part.  
e, Use the Software in violation of any international law or regulation.  
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
 



 
Display of Copyright Notices  
 
All copyright and proprietary notices and logos within the Software files must remain intact.  
 
 
Indemnity  
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license.  
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. Escape Motions may also make improvements and/or 
other changes to the Software at any time without notice.   
 
 
Disclaimer Of Warranty  
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED,  AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE.  FURTHER, PETER BLASKOVIC DOES NOT WARRANT 
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.  
 
 
Limitations Of Liability  
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH 
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING 
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 
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